Don't know where to start?
Read these tutorials:

**How to remove trial restrictions**
Save your video without a watermark and use the program after 7 days.

**Make a quick video**
Have your video ready in just 5 minutes using the new Montage Wizard.

**Make a video from scratch**
Learn how to do basic editing using the Timeline.

More questions?
Write us an e-mail at support@movavi.com
Table of contents

Activating Video Editor .................................................................................................................. 2
Activating without Internet access .................................................................................................. 3
Managing subscription ....................................................................................................................... 5
Activating and installing packages .................................................................................................. 5
Quick Start ...................................................................................................................................... 6
Quick Video mode ............................................................................................................................ 8
Creating and managing projects ...................................................................................................... 10
Project settings .................................................................................................................................. 11
Appending a project ......................................................................................................................... 13
Adding media ..................................................................................................................................... 13
Creating an intro ............................................................................................................................... 14
Recording video ............................................................................................................................. 14
Preview and organize clips .............................................................................................................. 16
Gaps on the Timeline ....................................................................................................................... 17
Edit and enhance clips ..................................................................................................................... 19
Rotating videos and images ............................................................................................................. 20
Cutting clips ...................................................................................................................................... 21
Cropping .......................................................................................................................................... 23
Color adjustments ............................................................................................................................ 24
Video speed ....................................................................................................................................... 25
Reversing video ............................................................................................................................... 26
Image duration .................................................................................................................................. 27
Fading video ....................................................................................................................................... 28
Creating overlays ............................................................................................................................. 29
Adding a watermark ....................................................................................................................... 32
Creating a freeze frame ................................................................................................................... 33
Removing black bars ....................................................................................................................... 34
Fading effects .................................................................................................................................... 35
Adding and editing audio .................................................................................................................. 36
Recording audio ............................................................................................................................... 37
Extracting audio from videos .......................................................................................................... 38
Looping audio .................................................................................................................................... 39
Volume curves .................................................................................................................................. 39
Linking audio ..................................................................................................................................... 40
Fading audio ...................................................................................................................................... 40
Equalizer .......................................................................................................................................... 41
Noise removal .................................................................................................................................... 41
Audio effects ..................................................................................................................................... 42
Beat detection ...................................................................................................................................... 43
Synchronization ............................................................................................................................... 44
Effect packages collection .............................................................................................................. 45
Filters ................................................................................................................................................ 47
Transitions ......................................................................................................................................... 48
Tiles .................................................................................................................................................. 50
Timer .................................................................................................................................................. 51
Stickers ............................................................................................................................................. 51
Animation ......................................................................................................................................... 52
Pan and Zoom ..................................................................................................................................... 54
Stabilizing video ............................................................................................................................... 56
Highlight and conceal ...................................................................................................................... 58
Logo .................................................................................................................................................. 60
Chroma key ....................................................................................................................................... 61
Exporting videos ............................................................................................................................... 62
Export only audio ............................................................................................................................. 64
Export for devices.............................................................................................................................. 65
Export for TVs .................................................................................................................................. 67
Uploading online ............................................................................................................................... 69
Partial project export ....................................................................................................................... 71
Video Editor preferences ............................................................................................................... 73
General preferences ....................................................................................................................... 73
File preferences ............................................................................................................................... 74
Sharing preferences ......................................................................................................................... 75
Acceleration preferences ............................................................................................................... 76
Help and support ............................................................................................................................. 76
System requirements ...................................................................................................................... 76
Supported formats ........................................................................................................................... 77
Codec activation ............................................................................................................................... 78
Glossary ............................................................................................................................................ 78
Export troubleshooting ..................................................................................................................... 80
Creating an Instagram video .......................................................................................................... 80

Activating Video Editor

When you first start Movavi Video Editor Plus, it will be running in TRIAL MODE. To use the program without trial restrictions, you will need to buy a license and activate Movavi Video Editor Plus. If you don't have an activation key yet, click the button below to visit our website and purchase one.
Activate the program
1. Launch the program.
2. Under the Help menu, select Activate Software.
3. Copy the activation key from your e-mail and paste it into the activation dialog box.
4. Click Activate.

Activating without Internet access
If the computer you have installed Movavi Video Editor Plus to is not connected to the Internet, you can activate the program via email.

See detailed instructions

If you don’t receive your activation key within an hour:
• Check the Spam folder of your mailbox.
• Contact Support.

I bought Movavi Video Editor Plus, but my videos already have a watermark.
After you have activated the program, you can open the movie project and re-export the video without the watermark.

How to export videos

Activating without Internet access

1. Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail. If you already have a key, skip to the next step.

2. Open the program and go to Movavi Video Editor Plus menu > Activate software
3. Enter your activation key and select the Activate offline option. Click Activate.

4. In the next window, click Copy and transfer this information to a device with an Internet connection.
5. When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You should receive a reply within an hour. Copy the activation key from the reply and transfer it to the computer with Movavi Video Editor Plus installed.

6. Return to the offline activation dialog box. If you've closed it, repeat steps 1-3 and enter the same activation key you used before. Then, paste the activation key into the box and click Activate.

If the activation is unsuccessful
- Make sure that you have entered the activation key correctly. There should be no additional characters or spaces after the last digit.
- Also make sure that the key you used is meant for Movavi Video Editor Plus.
- Before attempting to activate, deactivate your antivirus software and firewall.
Managing subscription

If your subscription has expired, you must renew it to continue using the program.

To renew your subscription, click the Renew Subscription button. A web page will open, where you can buy an activation key. Once you’ve completed the purchase and received the activation key by email, copy the key and paste it into the program activation dialog box. Then click Activate.

Having trouble renewing the subscription?

• If you don’t receive an e-mail with the activation key within an hour, check your Spam folder.
• Contact our support team. Our experts will help you solve any related issues.

Activating and installing packages

Expansion packages are sets of additional content, including transitions, titles, stickers, backgrounds, and music. Packages help you achieve your creative goals, broaden your expression capabilities, and save time by choosing the right artistic tools.

Acquiring a package

1. Go to the Movavi Effects Store. You can also find this link in the Help menu > Movavi Effects Store or by clicking the shopping cart icon in the effect, transition, title, or sticker collections.
2. On the Movavi Effects Store website, choose and purchase the packages you like. After the purchase is processed, you will receive an e-mail with an activation key, a link to download the package, and instructions on how to install it.

Installing a package

1. Click the link you received by e-mail to download the package.
2. When the download is completed, open the package as you would normally open a project: double-click the file or drag and drop it in the Video Editor. The program will start the installation process.
3. In the Installing Package dialog box, click Install and follow the instructions on the screen.
Activating a package
1. Copy the activation key from your email.
2. Paste it into the Activating Package dialog box.
3. Click Activate.

Wait until the installation is finished. The new elements will appear in the corresponding categories. Categories with new elements are marked with a yellow dot, and the elements are marked as NEW.

Cannot install or activate the package? Make sure that:
• The Video Editor you have installed on your system supports the package.
• You used the key that was emailed to you after purchasing the package and that there are no additional characters after the key.
• You have enough free disk space to install the package.

Quick Start
In this mode, you can use all the tools that the Video Editor has to offer and create professional-looking videos without complicated software. You can create a new video by creating a new project or a quick video.

1. To start creating a project, just add files to the Timeline. If you want to start another project, select Create New Project in the File menu.

2. Click Add Files or drag and drop your files to the import area to start working on them.
3. Change the clip layout on the Timeline, crop images, or cut videos using the toolbar.

4. Add effects, transitions, titles, and more by clicking the icons on the left-hand sidebar.

5. To add filters and transitions to the project, drag them to the Timeline.

6. Save your video:
1. Click the **Export** button.
2. Choose a file format.
3. Name the video, select a folder to save it to, and set the quality.
4. Click **Start** and wait until the processing is finished.

Be sure to occasionally save your work: click **Save** from the **File** menu to save the project.

### Quick Video mode

You can use the **Montage Wizard** to automatically build a video in minutes. All you need to do is provide the Wizard with some video clips or photos, choose a music track, and let the Wizard cut and build the video for you. You can also use the Montage Wizard to create slideshows.

1. On the **File import** tab, click **Quick Video** to open the Wizard.

2. On the **Files** tab, click **Add Files** or drag and drop your files to the window. To remove files, click the **X** in the top right-hand corner of each file, or select the files you want to delete and click **Delete Selected** in the bottom left-hand corner.

3. Switch to the **Templates** tab or click **Next**.
4. Choose a theme or a transition template. The **No transitions** template does not add any transitions to your video, but your pictures will still have a Pan and Zoom effect by default. The **Transitions** template applies smooth transitions between slides. The **Theme** template uses the sample music tracks, a set of different transitions for each theme, and various title styles.
5. Switch to the **Music** tab or click **Next**.
6. Add music. Choose from the built-in tracks* or add music of your own. You can add more than one track. *The audio tracks are royalty-free, so you can upload these videos to YouTube and other services.

7. Switch to the Preview tab or click Next.

8. Customize the opening and ending titles, change the text, and click Apply.

9. On the Advanced tab, make other desired changes.
   - Video duration
     You can set your video to be the same length as the audio by selecting the Fit to music length option or use the slider to set how long you want the video to be. If you opt for a shorter video, some clips may not appear in the end result.
   - Fill black bars
     If you've added clips with different resolutions to the project, black bars will appear on either side of the video. You can remove them by checking the Fit to frame option. The image resolution will be automatically fitted to the frame size.
     Learn more about frame size
   - Volume balance
     By moving the top slider to the right end, you can set the volume of the added video to maximum. By moving the bottom slider to the right end, you can set the volume of the background audio track to maximum.
   - Arranging clips
     If you have a lot of pictures and want to change their order in the video, click the Shuffle button. The Wizard will automatically arrange your files in a different order.
You can also set your desired order by returning to the Files tab and dragging the file icons in the order you want.

10. Watch the completed video on the Preview tab and then switch to the Export tab.

11. Select what you want to do next:
   • **Save the video**: Save the video to your computer.
   • **Continue editing**: Add final touches to your video by adding effects, more titles, animations, and more.
   • **Upload online**: Save the video to your computer and upload it to YouTube, Vimeo, Google Drive, or Movavi Cloud.

12. To save the video, choose a video format and select a folder to save the file to.
   If you’re uploading the video to YouTube, sign in with your YouTube account and add details about your video. Then click **Start** to begin saving and uploading the video.

Learn more:
Adding filters
Adding titles
Color adjustments
Removing black bars

---

**Creating and managing projects**

A project keeps all the work on your video or slideshow. You can save the project and continue your work later or restore your work if you need to edit something after you’ve finished it. A new project is created automatically when you start working on a video.

**Creating a new project**
1. On launching the Video Editor, you can start making a video right away.
2. To start a new project while working on another project, select Create New Project or Create Quick Video from the File menu.

**Saving projects**
1. Select Save Project from the File menu or pres ⌘+S on your keyboard.
2. Name your project. All projects are stored in the “/Movies/Movavi Video Editor/Projects” subfolder in your user folder.
3. Click **Save**.

You can later open the project file and continue working on it. To avoid losing your editing progress, be sure to occasionally save your project. To save a project, click **Save Project** in the File menu.

Your project will be saved to your computer as an *.mepx file. You can open it later to continue editing your video.

**Viewing videos**
Project files cannot be viewed in a regular video player. They can only be opened with Movavi Video Editor Plus. To view the final video in a player, you need to convert your project to a common video format.

Learn how to export your project
Opening projects
1. Select Open Project from the File menu.
2. Find the project file, select it, and click Open.

You can also open projects in other ways:
A. Find your project in File Explorer and drag it to the Video Editor window or double-click it.
B. On the File Import tab, click Add Files and select your project.

Restoring a project from an autosaved file
If your computer malfunctions and you cannot save the project, some of your work may be restored using an "autosave" file. Rename the "autosave.mepx" file and open it in Video Editor to continue working on your project.

Restoring media files
When you open a recent project, you may see a message saying that a file is missing from the project. This may happen if one or more files used in the project have been moved or deleted from your computer. In this case, click Specify Folder in the message box to specify the new location of the missing files or click Skip to open the project without the missing files. You can also click the magnifying glass icon to specify the new location of a single file. We recommend copying all the files to your computer before editing.

Project settings

How to change the video's resolution
You can adjust the parameters of your video, such as bitrate, video resolution and frame rate. These settings affect the quality and the size of a final file. You can change them when saving your video or at any other time.

In the Export window click the Advanced button.
**Video settings**
The video settings apply to all videos and photos used in the project.

**Video codec**
Codec is a program that encodes and decodes data. Codecs, as well as bitrate, use data compression and affect the size of a final media file, so it is easier to store and manage the file.

**Resolution**
The frame size or resolution determines the videos width and height in pixels. Open the Resolution list to select from the most common resolutions. For your convenience, each resolution is marked with its respective aspect ratio. Ideally, the frame size should match the resolution of the videos and photos you plan to use in your project, and should not exceed the resolution of the largest video. Smaller resolutions allow you to make the output video smaller and thus save your disc space, however, this will sacrifice some video quality due to downscaling.

To set your own resolution configurations, select the Custom option.

<table>
<thead>
<tr>
<th>Frame Size</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>320x240</td>
<td>4:3</td>
</tr>
<tr>
<td>640x480</td>
<td>4:3</td>
</tr>
<tr>
<td>1280x720</td>
<td>16:9</td>
</tr>
<tr>
<td>1280x960</td>
<td>4:3</td>
</tr>
<tr>
<td>1920x1080</td>
<td>16:9</td>
</tr>
<tr>
<td>1920x1440</td>
<td>4:3</td>
</tr>
<tr>
<td>3840x2160</td>
<td>16:9</td>
</tr>
<tr>
<td>4096x2160</td>
<td>256:135</td>
</tr>
</tbody>
</table>

**Frame rate**
Frame rate or FPS defines the frequency at which frames appear on a display per second. Frame rate affects the smoothness of the video being played. Standard frame rate in most types of videos is 24-30 frames per second. The video plays smoother at a higher value, but the file size rises as well.

**Bitrate**
Bitrate is the amount of digital information contained in one second of a media file. It is measured in kilobits per second (Kbps). You can control the output file size by changing the bitrate value. There are three types of bitrate available in the video editor: **Auto bitrate (CBR)** is a constant value set by the program and calculated according to other already set quality options such as video codec, resolution and frame rate. **Custom bitrate** is a constant manually entered value which is then used to process the entire video. This type of bitrate allows to predict the size of a final media file. **Variable bitrate (VBR)** is an automatically picked value that is set within the set quality requirements for the video. VBR will adjust to the image using the optimal values to save the quality: lower values for a static image and higher values for a more dynamic one. But in this case it is impossible to predict the output file size.

**Audio settings**

**Sample rate**
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music tracks.

**Channels**
Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording music; **mono** sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally preferred number of channels, however, some mobile devices record sound only in mono mode. **Surround sound (5.1)** has the capacity to produce sound using six channels (usually 5 speakers and a subwoofer), which allows it to create the so called participation effect. This technology is often used in home cinema systems, as well as in some game consoles and PCs.
Appending a project

If you're working on a big project, you may want to break it up to several smaller ones for a more convenient editing process. Then, you can recombine them into the major project.

1. Open a project or create a new one.
2. Select **Append Project** from the **File** menu.
3. In a new window, find and open the project you want to combine with your current project. The project you append will be added after all other clips in the current project.

Adding media

To begin working on your video project, you first need to add some media files. Use your own files or any of the built-in media.

**Add your files**
1. On the **File import** tab, click **Add Files**.
2. Select the files you want and click **Open**. They will appear on the **Media bin** tab.
3. From the **Media bin** tab, drag and drop the files onto the Timeline. You can unselect all files by clicking on an empty area on the **Media bin** tab or by selecting a single file.

**Add built-in media**
1. On the **File Import** tab, select the type of media you want: sounds, music, sample videos, or backgrounds.
2. Switch to a tab.
3. Click the file icon to download and preview or listen to it.
4. Choose a media file and drag it onto the Timeline to add it to the project.
**Arrange the files**
Once you've added the files, they will appear on the Timeline at the bottom of the window. The Timeline allows you to arrange the clips in the order you want. Select the clips you want to move and drag them to a new position.

**See also:**
[Working with video](#)
[Working with audio](#)

---

## Creating an intro

**Intro videos** are specially designed short video clips that use visual elements and text and can be edited or customized. If you don't know where to start in making a unique intro, you can use one of the ready-made videos included in the program. You will only need to change the text.

### Create a new intro
1. Click the **Titles** icon on the left-hand sidebar and select **Intro videos**.
2. Find the **New intro** clip and drag and drop it onto the Timeline.

![Image of intro creation](#)

### Edit the intro
1. Click the **Intro videos** icon on the clip, and the Timeline will switch to intro editing mode.
2. Add your own media files (video, audio, or pictures), effects, titles, and more. Work just as you would be working on a regular project, but keep in mind that you're making a special introductory video.
   
   *Before you start editing, delete the instructions clip that the **New intro** clip contains.*

### Save changes

1. Click **Apply and return** on the toolbar to save the changes and go back to the main editing mode.

To save the intro video and use it in other projects, select the intro clip and click **`.**. The intro will be saved with all the other items in the collection. You can edit it at any time while working on the project.

---

## Recording video

1. Connect a camera to the computer. Make sure that the system recognizes the camera and that it is working properly.
2. On the **File Import** tab, click **Record Video**. The recording module will open in a separate window.
3. Select the camera from the **Video capture device** dropdown menu.
4. Then, select a **resolution** and **frame rate**. A higher resolution will have better quality, but the video file size will be larger. A higher frame rate is necessary for recording motion, while static scenes can be captured with a lower frame rate.
5. Select the microphone from the **Audio capture device** dropdown menu.

6. Choose a destination folder. By default, the recordings are saved to your **Movavi Library** folder. To change the default folder, click the icon next to the **Save files to** field.

7. Click **Start Capture** to begin recording the video. During capture, you can take snapshots using the camera icon.

8. When you're done, click **Back to editing** at the bottom of the window. The captured files will be added to the Timeline and saved to your computer.
Preview and organize clips

Use the player in the top right-hand part of the window to preview your project.

**Current position**
You can control the current playback position using the position marker in the player and on the Timeline.

For precise positioning:
- To move in 0.5-second increments, open the **Playback** menu and select **Skip Forward by 0.5 Seconds (###)** or **Skip Backward by 0.5 Seconds (###)**.
- To move precisely from frame to frame, use the **Previous frame (###)** and **Next frame (###)** buttons in the player.
- To switch between clips, use the **Previous clip (###)** and **Next frame (###)** buttons in the player. This will move the position marker exactly one frame backward or forward.
- Use the **Scale** slider to zoom in on the Timeline to make positioning easier.

**Playing the video**
1. Move the position marker to where you want to start playback.
2. Click **Play** or press the space bar key.
3. Click the **Pause** button or press the **space bar** again to pause playback.
Arranging clips
By default, media files appear on the Timeline in the order in which you've added them. To rearrange the clips, drag and drop them to the desired position. To select multiple clips, use #+click or click and drag to draw a selection on the Timeline.

Gaps on the Timeline
Gaps on the Timeline are empty spaces between clips on a video track.

Adding gaps
1. To enable gaps, click the arrow icon in front of the video track.

Or right-click on the area in front of the track and select Enable Gaps on Track from the context menu.

2. To add a gap, click on a clip and drag it to the desired distance from another clip.
Deleting gaps
1. Right-click on the gap you want to delete.

2. Select **Delete Gap** to remove the selected gap. Select **Delete All Gaps** to delete all the gaps on the track. When you delete gaps, the clips will adjoin each other.

Ripple delete
To delete a clip on the track and move all the clips on its right according to its length without deleting gaps, right-click the clip you want to delete and select **Ripple Delete**.

Disabling gaps on a track
To disable gaps and adjoin all clips to each other, click the **crossed-out arrow** icon in front of the video track.
Or right-click on the area in front of the track and select **Disable Gaps on Track** in the context menu.

**Edit and enhance clips**

Arrange, edit, and enhance clips with the tools found on the toolbar and in **More Tools** on the left-hand sidebar.

The table below shows what tools you can use on clips and how to apply them.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split</td>
<td>Set the position marker on the Timeline where you want to separate your clip and cut it.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Rotate the clip clockwise.</td>
</tr>
<tr>
<td>Crop</td>
<td>On the player, select the area of the clip you want to keep and cut out the borders.</td>
</tr>
<tr>
<td>Adjust color</td>
<td>Make the desired color changes manually or using presets.</td>
</tr>
<tr>
<td>Turn the sound up or down</td>
<td>Click <strong>Clip Properties</strong> and use the volume slider to adjust the volume.</td>
</tr>
<tr>
<td>Normalize the video sound</td>
<td>Check the <strong>Normalize</strong> checkbox in <strong>Clip Properties</strong> to make the sound smoother.</td>
</tr>
<tr>
<td>Change video speed</td>
<td>Click <strong>Clip Properties</strong> and use the <strong>Speed</strong> slider to make the video faster.</td>
</tr>
<tr>
<td>Reverse the video</td>
<td>Check the <strong>Reverse</strong> checkbox in <strong>Clip Properties</strong> to play the clip from end to start.</td>
</tr>
<tr>
<td>Change opacity</td>
<td>Move the <strong>Opacity</strong> slider to adjust the clip’s transparency.</td>
</tr>
<tr>
<td>Change clip length</td>
<td>To change the clip length, move the borders of the clip on the Timeline or use the <strong>Speed</strong> slider to make the clip faster.</td>
</tr>
<tr>
<td>Make clip fade in or out</td>
<td>Use the <strong>Fade in</strong> and <strong>Fade out</strong> sliders to make the clip appear and disappear smoothly.</td>
</tr>
</tbody>
</table>
Edit videos and images
Photos and videos aren’t always perfect from the beginning. Use the buttons on the toolbar to fix and adjust clips.

Picture-in-picture and overlays
To overlay one video or image on top of another, select the clip you want to show on top and drag it upward, toward the top of the Timeline, to create an extra overlay track. Then, double-click it to set where the overlay will be shown on the video.

Learn more about overlays

Rotating videos and images
Nobody likes vertical videos! Don’t worry, with just a few clicks, you can rotate any photo without having to crane your neck.

Rotating by 90 degrees
1. Select the clip you want to rotate.
2. Click the Rotate button on the toolbar to rotate the clip by 90 degrees clockwise. Click the button again to rotate by another 90 degrees.
Learn more:

Removing black bars

Fixing the horizon level
1. Select the clip on the Timeline.
2. Click the Crop button on the toolbar.
3. Use the Angle slider to slightly rotate the clip inside the frame until the horizon is level with the guides in the player.

Cutting clips

Use the scissors button on the toolbar to cut video and audio clips into parts. To delete a clip you don’t need, click the trash can button.

Splitting clips into parts
1. Select the clip that you want to split.
2. Move the position marker to the moment where you want to cut the clip.
3. Click the Split button on the toolbar.
Cutting out fragments

Cut the clip at the beginning of the unwanted fragment.
1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the Previous Frame and Next Frame buttons on the player to catch the moment precisely.
3. Click the Split button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.

Cut the clip at the end of the fragment.
1. Select the second clip you just cut out.
2. Move the position marker to the end of the fragment.
3. Click the Split button again. The fragment should now be in a separate clip.

Delete the unwanted fragment.
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the Delete key. The clip will be removed, and the remaining clips on the Timeline will move to close the gap.

Trimming clips

If you only need to cut out some parts at the beginning or at the end of a video or audio clip:
1. Place your mouse pointer over the edge of the clip.
2. Click and drag the edge toward the center of the clip to trim it to the desired length.

For more precise navigation:
- Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second forward or backward.
- Press ### and #### to move the position marker half a second backward or half a second forward, respectively.
- Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the ## and ## keyboard shortcuts.
Cropping

Cropping a video can help you remove black bars, cut out the edges of the video, or permanently zoom in on an object inside a frame.

1. Select a clip on the Timeline.
2. Click the Crop button on the toolbar to open the crop tool. A cropping frame will appear in the player.

3. Adjust the frame so that the parts you want to cut are outside it. Click on any of the frame’s corners and drag to resize it. Click anywhere inside the frame and drag to move it.

Use the Angle slider on the Crop and Rotate tab to rotate the crop frame.
4. Click **Apply**. A star icon will appear on the clip once you’ve cropped it.

**Removing a crop**

1. Click the star icon on the clip to show a list of all applied effects and filters.

2. The **Clip Properties** panel will open. On the **Applied Effects** tab, find the **Crop** effect and click the **X** button on the right to discard it.

**Color adjustments**

**Change color settings**

1. On the Timeline, select the clip that you want to adjust.
2. On the toolbar, click the **Color Adjustments** icon to open the adjustments tool.

3. Select **Easy** mode to use color presets for quick and simple adjustments. You can also change the color of the video using color templates. To apply a template, drag it to the clip.
Or select **Advanced** mode to make adjustments manually.

If you want to save your manual adjustments for future use, click **Save Adjustments** and name your preset. The new preset will appear on the **Auto Adjustments** tab.

Once you have made your adjustments, the clip will be marked with a star icon ☀️, denoting applied tools or filters.

**Video speed**
Speed up or slow down a video or audio clip using the Speed slider. This can be useful if you're working on a music video and you want the video to match the tempo of the music.

1. On the Timeline, select the clip you want to edit.

You can also change the speed of any audio clip. If you modify the speed of a video with built-in audio, the audio speed will also be changed.

2. Click the Clip Properties button to open the editing tools for the selected clip.

3. Move the Speed slider to set the desired video speed.

The clip's length on the Timeline will change to reflect the new speed. If you change the speed of a video clip, it will be marked with a star icon.

Reversing video

Reversing a clip will play the video and audio backward. You can combine reversing a video with a faster speed and the VHS filter to create a cool rewinding effect.

1. On the Timeline, select the clip that you want to reverse. You can reverse both video and audio clips.
2. On the toolbar, click the Clip Properties button to open the properties for the selected clip.
3. Select the **Reverse** option.

When you apply the **Reverse** option, the clip will appear with a reverse icon on top of it.

**Image duration**

You can change how long each image appears in your video or slideshow. You can also set all images to the same duration.

**Changing one image's duration**

1. On the Timeline, select the image clip that you want to edit.
2. Click the **Clip Properties** button to open the properties for the selected image.
3. In the **Duration** field, enter the desired duration for the image in the following format: *hours:minutes:seconds.milliseconds*. The changes will be applied instantly.

You can also change the duration of an image by selecting it on the Timeline and dragging its borders left or right. The longer the image appears on the Timeline, the longer it will play in your video or slideshow.

**Setting the same length for all images**

To set all the project’s images to the same length:

1. Click the **Transition Wizard** button on the toolbar.
2. In the **Transition Wizard** window, set the desired duration in the **Image slide duration** field. If you don’t want to use transitions to join your clips, select **No transitions** from the dropdown menu at the top.
3. Click **OK** to set all the images to the selected duration.

**Fading video**

You can add smooth fades to the beginning or end of a clip. For videos and images, you can use fading combined with animated transitions. For audio clips, you can create a smooth crossfade effect between audio tracks.

1. On the Timeline, select the clip that you want to fade.
2. Click the **Clip Properties** button on the toolbar to open the properties for the selected clip.
3. Set the fade length using the sliders on the Video tab.

**Fade in:** How long (in seconds) it will take the beginning of the clip to fade in to full opacity.

**Fade out:** How long (in seconds) it will take the end of the clip to fade out from full opacity.

---

**Creating overlays**

Overlays are video clips or images that are shown over the main video. You can use these to create a split-screen or picture-in-picture effect, add a logo or watermark, create a chroma key effect, or insert a short clip without cutting the main video.

1. Add files to the project: a background video and a foreground video or a photo.
2. Select a clip that should go on the overlay track and drag it over the main video track.
3. Place the clip on the overlay track at the desired position. You will see a line connecting the clip on the overlay track to the clip on the video track. When you move, cut, or delete a clip on the video track, the overlay clip will be affected accordingly. When you move the clip on the overlay track, the Overlay panel will open. If you switch to a different tool, you can go back to this panel by clicking More Tools on the left-hand sidebar and selecting Overlay under Video Editing.

---

See also:

* Adding transitions
* Fading audio
4. On the Overlay panel, select an overlay mode: Picture in picture, Logo, Overlap, Side by side, or Trio.

**Picture-in-picture mode**
This is the default overlay mode. Using this mode, you can place the overlay video over any part of the screen.
1. Click Picture in picture.
2. In the player, move the overlay clip to where you want it to appear in the frame.
3. To resize the overlay, click on any of the frame's corners and drag. Click anywhere inside the frame and drag to move it. The clip's aspect ratio will remain the same.

**Logo mode**
1. Select Logo mode to place the overlay clip at the top right-hand corner and use it as a logotype.
2. Drag the logo to any part of the frame.
**Side-by-side mode**
This mode splits the frame into two parts.
1. Select a clip on the overlay track and then choose a side-by-side mode.
2. Hover the cursor over the selected clip in the player. Move the image in the frame and zoom in or out on it with your mouse’s scroll wheel.

**Trio mode**
With this mode, you can have up to three videos in a single frame.
1. Select a clip on the overlay track and then choose a side-by-side mode.
2. Hover the cursor over the selected clip in the player. Move the image in the frame and zoom in or out on it with your mouse’s scroll wheel.
3. To add another video and get three in a single frame, add another clip to the overlay track and repeat steps 1 and 2.

**Overlap mode**
In Overlap mode, the video on the overlay track will cover the main video entirely. You can use this mode to avoid cutting the main video and showing another clip instead or to create a chroma key effect.
How to change background (Chroma key)

Adding a watermark

Adding a watermark to your video will protect your ownership even if it’s shared all over the Internet. You can add an image overlay with your own watermark or logo or create a new one using text.

**Image watermark**

1. Click the **Import** icon on the left-hand sidebar. On the **File import** tab, click **Add Files** and add the image or video that you want to use as a watermark. For the best look, use images with transparent areas.
2. Drag the watermark clip to the overlay track, above the other clips.
3. Double-click the watermark clip to edit the overlay, which you can move and resize in the player.
4. To change the opacity or duration of the watermark, click the **Clip Properties** button.
5. To adjust the opacity, move the **Opacity** slider. To make the watermark appear through the entire length of the video, enter your project’s length in the **Duration** field or drag the right edge of the overlay clip until the end of the video track.
Text watermark

1. Click the **Titles** icon on the left-hand sidebar and pick a nice title style for your watermark.
2. Drag the titles you like to the beginning of the titles track at the top of the Timeline.

3. Double-click the title and enter your watermark text. Pick a cool font and color on the panel above the player. Click **Apply** when you're done.
4. To make the watermark appear through the entire length of the video, drag the right edge of the text clip until the end of the video track.

   *OR*: Double-click the text clip to enter text editing mode and enter the length in the **Duration** field. You can see the length of the entire project at the bottom of the window.

Creating a freeze frame

A freeze frame is a single frame in a video that is repeated for some time, creating the illusion of a paused video. You can use freeze frames to highlight a moment or create a pause to explain things to the viewer.
1. Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous frame and Next frame buttons under the player.

2. Once you're on the right frame, open the Edit menu or right-click on the clip and select Insert Freeze Frame from the context menu.

3. By default, freeze frames are four seconds long. To change the duration, drag the edges of the clip to make the freeze frame shorter or longer.

Removing black bars

Sometimes, when you use videos with different aspect ratios, or if the project is set up incorrectly, black bars may appear on either side of a video. You can remove them in one of the following ways.
1. On the Timeline, select the clip with black bars.
2. Click the Filters icon on the left-hand sidebar.
3. On the Adjustments tab, select the Vertical fill filter and drag it onto the clip.

Learn more about filters

Manual crop
If black bars appear only in one or some clips, you can cut out the edges to make the video fit better inside the frame.
1. On the Timeline, select the clip with black bars.
2. Click the Crop button on the toolbar.
3. A frame will appear in the player. Move this frame to the part of the video that you want to keep. Parts that are outside the frame will be cut out.
4. Click Apply to accept the changes.

Learn more about crop

Fading effects
Make effects and filters fade in using the overlay track.
1. Copy a clip and paste it onto the Timeline.
2. Drag the copied clip on the track right above the original. Now you have two identical clips, with one on top of the other.
3. Double-click the clip on the overlay track and select Overlap mode on the panel above the Timeline.
4. Apply the effects or filters you want to use to the visible clip on top. Learn more: Applying filters

5. With the overlay clip selected, click the Clip Properties button and select General settings. There, move the Fade in and Fade out sliders to set the fading time. You can also use the Opacity slider if you want to reduce the effect’s strength for the entire clip.

The clip with the effect will gradually appear and disappear, exposing the underlying original clip.

**Adding and editing audio**

**Add audio**
1. To add music or other sounds to your project, click the Import icon on the left-hand sidebar.
2. On the File import tab, click Add Files or just drag and drop your files to the panel.

You can also use one of the built-in sound or music tracks:
1. Click the Sounds or Music category and choose from our royalty-free music collection.
2. Drag the tracks you liked on the Timeline.
Edit audio
To edit the audio file, double-click the clip. The **Clip Properties** panel will open.

<table>
<thead>
<tr>
<th>Volume</th>
<th>Sets the volume of the clip.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normalize</td>
<td>Reduces the difference between louder and softer sounds.</td>
</tr>
<tr>
<td>Speed</td>
<td>Makes the audio play faster or slower.</td>
</tr>
<tr>
<td>Fade in</td>
<td>The audio goes from completely silent to full volume in the specified time.</td>
</tr>
<tr>
<td>Fade out</td>
<td>The audio goes from full volume to completely silent in the specified time.</td>
</tr>
<tr>
<td>Reverse</td>
<td>Plays the audio backward.</td>
</tr>
</tbody>
</table>

**Recording audio**

1. Connect a microphone to your computer.
2. On the Timeline, place the position marker where you want the recording to start.
3. Click the **Import** icon on the left-hand sidebar. On the **File import** tab, click the **Record Audio** button to open the recording options.
4. Select your recording device from the dropdown menu and set the volume.
5. Click **Start Recording**.
6. When you're finished, click **Stop Recording**. The recording will appear on the Timeline.

**Set start time for audio clips**
After you've added the audio files, they will appear on the audio track of the Timeline as green clips. To change when the audio clip starts playing, move the position marker along the Timeline, using the ruler at the top for time reference.

**Extracting audio from videos**
You can extract a movie soundtrack from a video file and use it in your project.

On the **File Import** tab, click **Add Files** and choose a video or drag and drop it to the panel. The file will be added to the video track on the Timeline.

- How to trim the parts of the video if you don't need to extract the entire audio track:
  1. Move the position marker to the beginning of the fragment you want to keep and click the **Scissors** button on the toolbar. This way, you will cut out the beginning of the video.
  2. Move the position marker to the end of the fragment you need. Click the **Scissors** button again, and the fragment will now be in a separate clip.
  3. If you don't need the remaining fragments, select them on the Timeline and click the **trash can** button on the toolbar to delete them.

4. Audio that belongs to a video appears right underneath it on the video track. To separate it from the video, drag the audio stripe down onto the audio track. If you no longer need the video clip, just delete it.
You can now work on the extracted audio clip separately.

🖌️ If you want to save the audio clip for later use, you can export it as an audio file:
1. Click the Export button below the player.
2. In the Export Settings window, click the Audio File icon.
3. Select an audio format.
4. In the Save to field, you can see where the file will be saved by default. To change the default folder, click Browse and select a new folder.
5. Finally, click Start to save the audio file.

Looping audio
If the music file is shorter than your video, you can loop the audio until the end of the video.

1. To copy the audio clip, right-click on it on the Timeline and select Copy from the context menu.
2. Paste the audio clip onto the Timeline right next to the first clip. It will be inserted right after the position marker. Repeat until the audio length is equal to or greater than the video length.
3. Now the audio track may be longer than the video track. To trim it, drag the right edge of the clip to the left.

Volume curves
Each clip can have its own volume curve. Volume curves allow you to control the volume of each part of the clip and smoothly increase or decrease it.

Each clip has a point at the beginning and one at the end, and the entire clip’s volume is initially 100%. The white line in the screenshot below is the volume before you add any points.

Set the volume level
1. Drag the white line up or down to the desired level. The top of the clip is 100% volume, and the middle of the clip is 50%.
2. Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and select **Add Volume Point** from the context menu.

3. Drag the audio point to the desired volume level. You'll notice that the surrounding parts also move with the point to make the transition smoother.

4. Make as many points as you need for each part of the clip where you’d like a spike or a drop in volume.

5. To set the volume level for a part of the clip, you'll need at least two points. Create a point at the beginning and at the end of the fragment.

6. Create as many volume points as you wish to create the desired effect.

**Linking audio**

To make audio clips stay in sync with videos or images as you edit your project, link them to each other.

**To link an audio clip**

1. Select an audio clip on the audio track at the bottom of the Timeline.
2. Drag the track under the video clip you want to link it to.
3. On the left side of the Timeline, click the **Link** button to create the connection between audio and video clips.

**Fading audio**

You can add smooth fades to the beginning or the end of a clip and create a crossfade effect between audio tracks.

**Fade in**: How long (in seconds) it will take the beginning of the clip to go from silent to full volume.
**Fade out**: How long (in seconds) it will take the end of the clip to go from full volume to silent.

**Set up the fading effect**

1. Select the clip on the Timeline.
2. Click the **Clip Properties** button on the toolbar.
3. Set the fade length using the sliders on the **Clip Properties** panel.
Equalizer

Using the equalizer, you can boost or reduce the levels of specific frequencies.

**Set the equalizer**
1. Select the audio clip that you want to edit. This can also be a built-in audio track.
2. Click More Tools on the left-hand sidebar. On the Audio Editing tab, click Equalizer.

3. Choose an equalizer preset to quickly set an effect. If you want a more advanced configuration, move the loudness sliders to adjust the frequencies to the desired level.

4. To save your own equalizer presets for future use, click the Save button. In the new window, enter a preset name and click OK. The created preset will appear in the presets list.

Noise removal

1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click **More Tools** on the left-hand sidebar. On the **Audio Editing** tab, select **Noise Removal**.

3. Move the **Noise suppression** slider to set the amount of noise you want to remove.

   - Don’t set the noise suppression level too high if there isn’t much noise because it can result in muting other sounds.

### Audio effects

Audio effects can transform the sound of an audio clip.

1. Select the audio clip that you want to edit. This can also be a built-in audio clip.
2. Click **More Tools** on the left-hand sidebar. On the **Audio Editing** tab, click **Audio Effects**.
3. Select an effect from the **Audio Effects** dropdown menu.
Removing effects
When you apply an audio effect to a clip, a star icon will appear on it. Click on the star to see a list of all applied effects. To discard an effect, click the X button on its right.

Beat detection
To make your video more dynamic, use the Beat Detection audio tool to automatically mark audio beats on the Timeline and then adjust your video to the beat of the music.

1. On the Timeline, select the music that you want to detect beats for.
2. Click More Tools on the left-hand sidebar. On the Audio Editing tab, select Beat Detection.
3. In the Beat Detection tool, click Detect Audio Beats. The program will analyze the music and place beat markers on the Timeline.
After the beat markers have been placed, you can modify their tempo. Move the **Min. time between beat markers** slider to make the beat slower or faster.

4. Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the beat.

**Removing beat markers**
1. To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select **Remove Beats** from the context menu.
2. To remove all beat markers from your project, right-click the Timeline ruler and select **Remove All Beats** from the context menu.

**Synchronization**

Sync audio in two clips automatically.

1. Click **More Tools** on the left-hand sidebar. Under **Audio Editing**, select **Synchronization**.

2. Select two clips with audio. The clips must be on different tracks!
3. Click **Synchronize**.

When syncing, the clips move to the right relative to the later clip on the Timeline.
Effect packages collection

Adding an effect package

1. Click the Import icon on the left-hand sidebar and select the Effect packages tab.

The Available tab contains packages that you can purchase and use in the program. On the Installed tab, you can find packages that you have already purchased and installed in the program.

2. Click on a package to purchase it.
3. Check the contents of the shopping cart and proceed with the payment. Once the purchase has been completed, you will receive an activation key by email.

4. Click on the key icon on the package to activate it.
5. Enter your activation key in the dialog box that opens and click **Activate**.

6. After activating the package, you must download and install it. The key icon will change to a download icon on the image of the activated package. Click on the activated package to download and install it.

7. The package will be installed automatically after downloading.
Tabs containing newly downloaded content will be marked with a yellow dot.

 Viewing and deleting installed packages
1. To view installed packages, select the Installed tab.
2. To delete a package, click the X icon in the top right-hand corner of the package image.

 Filters

**Add filters**
1. Click the Filters icon on the left-hand sidebar.
2. Select All to see all the filters in the collection or choose a specific category.
3. Click on a filter to preview it in the player.
4. To find a specific filter, enter its name in the search box above the filters.
5. Click the heart icon to add a filter to your Favorites.
6. To add a filter, drag it onto the clip you want to apply it to.

You can apply a filter to several clips at once. Hold the ⌘ key, select the clips on the Timeline, and drag a filter onto any one of the selected clips. The filter will be applied to all the selected clips.

When you apply a filter, a star icon will appear on the clip, indicating applied filters and tools.

Remove filters
1. To see a list of all applied filters and tools, click on the star icon on the clip.
2. Find the filter that you want to remove and the X button to discard it.

Transitions
Transitions are short animations that use geometric shapes and transparency to connect two clips.
**Add a transition**

1. Click the **Transitions** icon on the left-hand sidebar to open the list of all transitions. Click on a transition to preview it in the player.
2. Pick a style you like and drop it between two clips on the Timeline. Click the heart icon to add it to your **Favorites** list if you like.

![Transition icon between clips](image)

A transition icon will appear between the two clips.

**Change the transition length**

1. Double-click a transition on the Timeline to open the transition properties.
2. By default, transitions are 2 seconds long. Enter a new transition length in the **Transition duration** field. The format is `seconds:milliseconds`. If you want all transitions in a project to have the same length, select the **Apply to all transitions** option.
3. Click **OK** to apply the changes.

![Transition properties dialog](image)

More transition options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trimmed content</td>
<td>If you’ve trimmed a video, the trimmed bits will appear during the transition. If a video hasn’t been trimmed, a freeze frame is shown.</td>
</tr>
<tr>
<td>Freeze frame</td>
<td>A static frame is shown during the transition.</td>
</tr>
<tr>
<td>Slow motion</td>
<td>The part of the video overlapped by the transition is stretched to fill the entire duration.</td>
</tr>
</tbody>
</table>
Remove a transition
1. Right-click the transition on the Timeline and select Remove Transition from the context menu.
2. If you want to delete all the transitions in your project, select Remove All Transitions.

Titles

Add text to your video
1. Click the Titles icon on the left-hand sidebar to view the title collection.
2. Click on a title style to preview it in the player. To add titles to your Favorites, click the heart icon.
3. Pick a title style and drag it onto the title track of the Timeline. Place it right above the video track, at the time where you want it to appear. You can link titles to the clip by clicking the link button on the left side of the title track. The titles will move with the clip. You can separate the titles from the clip by clicking the same button.

Edit a title
To change a title, double-click the title clip on the Timeline. A title Clip Editing panel will appear.

<table>
<thead>
<tr>
<th>Text</th>
<th>Edit your text, choose the title style, and add an outline and a background using these options.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip</td>
<td>Change the duration and animation speed of the title.</td>
</tr>
<tr>
<td>New Preset</td>
<td>Create a new preset with your personal settings and save it for future use. Your title will appear in the My titles collection.</td>
</tr>
<tr>
<td>Color</td>
<td>Choose an object in the player and change its color.</td>
</tr>
</tbody>
</table>
**Timer**

**Add a timer**
1. Click the Titles icon on the left-hand sidebar to open the list of available text styles.
2. Find the Timer title style. Use the search bar or click the Basic tab to filter styles.
3. Drag the timer title onto the title track of the Timeline. To change the timer’s length, drag the edges of the clip.

**Edit a timer**
Double-click the timer clip on the Timeline to open the title Clip Editing panel.

<table>
<thead>
<tr>
<th>Text</th>
<th>You can choose the timer’s style, add an outline, and change the color of the background.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip</td>
<td>Change the timer’s duration.</td>
</tr>
<tr>
<td>New Preset</td>
<td>Create a new preset with your personal settings and save it for future use. Your preset will appear in the My titles collection.</td>
</tr>
<tr>
<td>Timer</td>
<td>Select the timer’s format or add a countdown to the video.</td>
</tr>
</tbody>
</table>

**Stickers**

**Add stickers**
1. Click the Stickers icon on the left-hand sidebar to open the list of stickers.
2. Select a sticker and drag it onto the title track of the Timeline. All titles, callouts, and stickers go on the title track. Change the sticker’s length to make it fit the clip.
Edit a sticker
1. Double-click to open the sticker Clip Editing panel.
2. Select the sticker’s duration.
3. Click Apply to save the change.

4. To change the sticker’s position in your video, double-click the sticker clip. In the player, drag any corner of the frame around the sticker to change its size. Click anywhere inside the frame and drag to move it. To rotate the sticker, click and drag the white dot above the frame.
5. Click Apply when you’re finished.

Transitions cannot be applied to stickers, but you can animate them.

Learn more: Animation

Animation

You can move objects any way you want and make creative effects.

Add an animation
1. Add a background to the main video track.
2. Add the object you want to animate.
3. Click More Tools on the left-hand sidebar and select Animation under Video Editing.

4. Select Easy mode to add quick and simple animations. To use a preset, just drag it onto the clip.

To create your own unique animation, select Advanced mode.

**Advanced mode**
1. Select the clip you want to animate and place the position marker where you want your animation to start.
2. On the Animation panel, click Add Animation.

3. In the player, you will see a frame appear around the object. Move it to set the object’s position.

📝 On the Timeline, two points will appear on the clip. These are called keyframes. The first point is the original position of the object. The second point will be its end position after the animation. The distance between the two points determines the animation speed.
Edit a keyframe
On the Timeline, double-click a keyframe to edit it. Adjust the animation:

| Move the object on the player | Move the frame of the object. |
| Change the object’s size | Drag any of the frame’s corners. |
| Rotate the object | Drag the white dot above the frame. |
| Make the object spin | Use the Angle slider on the Animation panel. |
| Make the object fade in or out | Use the Opacity slider on the Animation panel. |

Change the speed of your animation
Move the keyframe points on the clip:
• Move the points closer together to make the animation faster.
• Move the points farther away from each other to make it slower.

To add another keyframe, move the position marker to where you want to place it on the clip and click Add Keyframe on the Animation panel.

Reset a keyframe
To make a keyframe go back to its original position, right-click the keyframe point on the clip and select Reset Keyframe from the context menu.

Remove keyframes
1. To remove one keyframe, right-click the keyframe point on the clip and select Remove Keyframe from the context menu.
2. To remove all keyframes and delete the animation, right-click any of the keyframe points and select Remove All Keyframes.

Not available in Movavi Video Editor Academic Edition.

Pan and Zoom
You can control the camera movement using two keyframes and smoothly move from one frame to another.

**Add a Pan and Zoom effect**
1. On the Timeline, select the clip that you want to zoom on.
2. Click the More Tools icon on the left-hand sidebar and select Pan and Zoom under Video Editing.

![Pan and Zoom interface](image)

3. Click one of the presets to apply it.

🎨 This will add two keyframes to the clip. The camera will move between these two keyframes, and you can set up camera movements from one point to another.

4. To change the beginning keyframe, double-click the first point on the clip. Then, use the frame in the player to set the zoom level for the starting point of the camera movement.
5. To change the ending keyframe, double-click the second point on the clip. Then, use the frame in the player to set the zoom level for the ending point of the camera movement.

![Keyframe editing interface](image)

⏰ To change the length of the zoom effect, move a keyframe left or right. To move the zooming effect on the clip without changing its length or other settings, move it along the clip.
If you want to add more camera movements, repeat steps 2-4 to combine other camera movements in one clip. For example, you can zoom in on an object, pan across the frame with the same zoom level, and then zoom back out to 100%.

**Add the Pan and Zoom effect to all image clips automatically**

1. Select the desired images on the Timeline.
2. Click the Transition Wizard button on the panel above the Timeline.
3. Check the Enable Pan and Zoom effect checkbox.
4. Click OK to apply the effect to the clips.

**Remove zoom**

To remove a pan or zoom effect, right-click a keyframe and select Remove Keyframe to remove the specific keyframe or Remove All Keyframes to clear all zoom effects from the clip.

**Stabilizing video**

If you’re filming with a handheld camera, there might be some unwanted camera shake in the video, especially if you’re walking or moving while filming.

**Stabilize a video**

1. On the Timeline, select the clip you need to stabilize. To make the process faster, you can cut the video into smaller segments.
2. Click the More Tools icon on the left-hand sidebar and select Stabilization under Video Editing.
3. Click **Stabilize**. The **Stabilization** settings window will open.

![Stabilization settings window](image)

4. Configure stabilization with the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Accuracy</strong></td>
<td>Affects the analysis precision of the video.</td>
</tr>
<tr>
<td><strong>Shaking</strong></td>
<td>Sets how strongly the shaking is visible on the video.</td>
</tr>
<tr>
<td><strong>Radius</strong></td>
<td>When a video is stabilized, each object is adjusted using pixels from the surrounding area. The radius affects how large that area will be. Use a smaller value for more dynamic videos, to avoid mixing objects, and to preserve more detail.</td>
</tr>
<tr>
<td><strong>Smoothing</strong></td>
<td>Limits the camera acceleration. Higher values work best for more or less static videos. Excessive smoothing may limit panning.</td>
</tr>
</tbody>
</table>
| **Edge cropping** | Eliminates distortion artifacts like blurred areas from the video. You can select one of the following options:  
  - **None**: The edges will remain as they are. Best results if there is little shaking in the video.  
  - **Fixed**: The video is cropped to one size to cut out some of the edges.  
  - **Adaptive**: Wherever there is a lot of shaking, the video will zoom in so that the distorted edges are not shown. |

5. Click **Stabilize** to start processing the video.

![Stabilization settings window](image)

6. To save the result, click **Apply**. The clip on the Timeline will be replaced with the stabilized video.

A stabilized copy of the file will be saved in "\My Videos\Movavi Video Editor\Stabilized." This copy will be used in the project. If you delete it, you will lose all the changes.

If you don't have enough disk space to save the stabilized copy, you can free up some space and try again or save your stabilized copies on another disk:
1. Select **Preferences** from the **Settings** menu.
2. Switch to the **Files** tab.
3. Find the Store stabilized videos in field and click the button on the right to choose a folder on another drive.
4. Click OK to accept the changes.
5. Try stabilizing the video again.

**Highlight and conceal**

This tool will help you control the focus in a frame and blur or darken parts of a video.

**Apply the Highlight and Conceal tool**
1. On the Timeline, select the clip that you want to edit.
2. Click the More Tools icon on the left-hand sidebar and select Highlight and Conceal under Video Editing.

3. Select Conceal if you want to hide an object or Highlight if you want to make an accent on the object.

4. Choose a shape for the mask: rectangular or elliptical.
5. Choose a masking effect: Blur, Matte (black cover-up), or Pixels. Use the options below to configure the mask:
   - **Opacity**: Makes the mask more transparent (for matte and blur).
   - **Feathering**: Makes the edges of the mask softer (for matte and blur).
   - **Size**: Changes the size of the pixels (for pixel masks only).
   - **Outline**: Adds a white outline around the mask.
6. To change the size and shape of the mask, drag any of its corners in the player. Click anywhere inside it to move it.

7. Click **Apply** on the Highlight and Conceal panel to save the changes.
Add your own logo to an entire video with the **Logo** tool.

1. Click the **More Tools** icon on the left-hand sidebar and select **Logo** under **Video Editing**.

2. Add the image you want to use as a logo by clicking the **Add Logo** button.

The logo file moves to the overlay track, and the logo itself is placed in the bottom right-hand corner of the video in the player.
Chroma key

The chroma key effect allows you to remove any color from an image or video, leaving the background transparent.

Add Chroma Key
1. Add the video or image clips that you want to use as the foreground and the background.
2. Select the foreground video and move it up onto the overlay track.
3. Double-click the foreground video to open Clip Properties.
4. To make the foreground video cover the background video entirely, select Overlap mode on the Overlay tab.

5. Click the More Tools icon on the left-hand sidebar and select Chroma Key under Video Editing.

6. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to remove. The color will become transparent.
   Please note that it’s better to use green or blue colors. Don’t use black, white, or gray.
Use more settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tolerance</td>
<td>Set how many similar shades of the selected color should also be removed.</td>
</tr>
<tr>
<td>Noise</td>
<td>Choose how sharp the object’s edges should be.</td>
</tr>
<tr>
<td>Edges</td>
<td>Choose how thick the object’s edges should be.</td>
</tr>
<tr>
<td>Opacity</td>
<td>Set the transparency of the background.</td>
</tr>
</tbody>
</table>

7. Finally, click **Apply** to accept the changes.

---

**Exporting videos**

When you’re finished with your project, you’ll need to export it as a media file to be able to play it in media players. This section will guide you through the process of exporting your project to popular video formats. If you want to find out more about other ways of saving videos, see the following guides:

- [Saving videos for devices](#)
- [Uploading videos online](#)

**Export a video**

1. To save a video, click the **Export** button under the player. The Export Settings window will open.
2. Choose a video file format.
Some formats allow you to choose video codecs. If you don’t know which format to choose, try using MP4. The MP4 format is supported by most media players. At lower resolutions, the file size will be significantly smaller. However, there will be some quality loss due to compression.

The **GIF** format is different from the other formats in the list. It allows saving a video as a silent animated image, which can then be played in some image viewing programs or in any web browser.

3. If you want to change the resolution, aspect ratio, or other settings, click the **Advanced** button. To save the changes, click **OK**.

4. Name your file and choose a destination folder.

In the **Save to** field, specify the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in **Preferences**. To select a different folder, click the **Browse** button and choose a folder in File Explorer or type the path in the field. Type a name for your video in the **Title** field. The project’s name will be filled in for you by default.

5. Choose the video quality.
If your project contains many small details and filters, you can select High or Highest quality to export the video with a higher bitrate. Note that this will increase the output file size. For most other projects, Good quality will provide a decent result at a small file size.

6. Click the **Start** button to begin processing the video file. This may take a few minutes.

---

**Export only audio**

This section will guide you through exporting only the audio track of your project.

**Export an audio track**

1. Click the **Export** button below the player to open the **Export Settings** window.

2. Click the **Audio File** icon on the left of the **Export Settings** window.
3. Select an audio format.

While MP3 is the most common format, supported by almost all media players and devices, FLAC offers higher audio quality but results in considerably larger file sizes. When choosing an output format, it is important to note the quality of the original files: due to data compression limitations, digital audio quality cannot be restored from a very low-quality file by exporting as FLAC; conversely, a high-quality file may lose some of its quality when saved to MP3 format, which is limited to 320 Kbps.

4. Name your file and choose a destination folder.

In the Save to field, specify the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in Preferences. To specify a different folder, click the Browse button and select a folder in File Explorer or type the path in the field. Type a name for your audio in the Title field. The project's name will be filled in for you by default.

5. Click the Start button to begin processing the audio file.

Export for devices

This guide will help you export your video project for playing on cell phones, tablets, and other devices.

1. Click the Export button below the player to open the Export Settings window.
2. On the left of the Export Settings window, click the Devices icon.

3. Choose a device. Here you will find a number of different types of devices for which you can choose a format. You can choose between devices running iOS (iPhone, iPad, iPad mini) or Android (such as Samsung Galaxy S6/S7, Google Nexus 6, and Google Pixel), as well as PlayStation and Xbox consoles. If your device is not on the list, choose Other.

You can select High or Highest quality to export the video with a higher bitrate. This will increase the output file size. For most projects, Good quality will provide a decent result at a small file size.
4. Name your file and choose a destination folder. In the **Save to** field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos specified in Preferences. To specify a different folder, click the **Browse** button and select a folder in File Explorer or type the path in the field. Type your video’s name in the **Title** field. The project’s name will be filled in for you by default.

5. Click the **Start** button to begin processing the video file. This may take a few minutes.

---

**Export for TVs**

This guide will help you export your video project for playing on smart TVs.

1. Click the **Export** button below the player to open the Export Settings window.

2. On the left of the Export Settings window, click the **TV** icon.
3. Choose your TV brand and resolution. If your TV is not on the list, choose Other 1080p TVs or Other 4K TVs.

If your project contains many small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate. This will increase the output file size. For most other projects, Good quality will provide a decent result at a small file size.

4. Name your file and choose a destination folder. In the Save to field, enter the folder where you would like to save the file. By default, this will be the directory for saving output videos specified in Preferences. To specify a different folder, click the Browse button and select a folder in File Explorer or type the path in the field. Type a name for your video in the Title field. The project’s name will be filled in for you by default.

5. Click the Start button to begin processing the video file. This may take a few minutes.
After you finish your video, you can upload it to YouTube, Vimeo, or Google Drive right from the Export Settings window.

**Upload to the Internet**

1. Click the **Export** button to open the Export Settings window.

2. On the left side of the **Export Settings** window, click the **Upload** icon.

3. Select the service you would like to upload your video to: YouTube, Vimeo, or Google Drive.
4. Click **Sign in**. The authentication page will open in your browser. Sign in to your account and click **Allow** to let Movavi Video Editor Plus upload videos.

### Upload to YouTube
1. Type a **Title** and **Description** for your video.
2. Add some **tags** to help users find videos by relevant topics. Separate tags with commas and add a hashtag (＃) before each one.
3. Choose a **Category** to help viewers find relevant content.
4. From the **Privacy** dropdown menu, choose who you want to see the video:
   - **Private**: Videos can only be seen by you and users you choose.
   - **Unlisted**: Videos can be seen and shared by anyone with the link.
5. Click **Upload** to export and upload your video.

### Upload to Google Drive
1. Type a **Title** for your video.
2. Select a Google Drive folder where you want your video to be uploaded. You can create a new folder in your Google Drive straight from the Export Settings window.
3. From the **Privacy** dropdown menu, choose who you want to see the video:
   - **Private**: Videos can only be seen by you and users you choose.
   - **Unlisted**: Videos can be seen and shared by anyone with the link.
4. Click **Upload** to export and upload your video.
Upload to Vimeo
1. Type a Title and Description for your video.
2. Select a video resolution from the Resolution dropdown list.
3. Select a privacy level from the Privacy dropdown list:
   Anyone: Any person can watch the video.
   Only people I follow: Only people you are following can watch the video.
   Only me: No one but you can access the video.
4. Add Tags.
5. Click Upload to export and upload your video.

Save and upload the video
Before uploading, the video will be saved on your computer.
1. To change where the video file is saved, click Browse and select a folder.
2. Click Upload to export the video.

Partial project export
Edit and save different parts of the project separately using partial project export.
Adding and editing a selection
1. To select a part of a project, first add the selection to the Timeline. To add the selection, place the position marker at the beginning of the part you want to export and then click Add Selection from the Export menu.

2. To edit the size of the part, move the position markers by clicking and dragging their round parts.

Deleting a selection
To delete a selection, right-click on the selected area and select Delete Selection from the context menu.

Exporting the selection
1. To export the selection, right-click on the selected area and select Export Selection from the context menu.

2. In the window that opens, type a name for the project and select the folder where it will be saved. To save the selected area, click Start.
Video Editor preferences

To set your program preferences:
1. Select Preferences in the Settings menu.
   The Preferences window will open. The preferences are organized in tabs. Click on a tab to see the relevant options.

   ![Preferences window]

3. When you're done, click OK to apply your preferences and close the window.

See also:
- General preferences
- File preferences
- Sharing preferences
- Acceleration preferences

### General preferences

**Interface Language:** To change the interface language, simply select the desired language from the list and click OK to apply the changes.

**Automatically check for updates:** Select this option, and you'll be notified whenever a new version is available. Updates within your version are absolutely free (e.g., from 1.0 to 1.1), while new releases are offered to registered users at a generous discount.

**I give consent to send anonymous usage stats to Movavi:** Check this box to let the program send usage statistics to our development team and help us fix all the problems in the program faster. The data contains no personal information, will be used for software improvement purposes only, and will not be disclosed to third parties.

**Play notification sound when exporting is finished:** When exporting a project as a media file, you'll be notified when the process is completed.
File preferences

On the **Files** tab, you can find options for saving different kinds of files. You can change any of the default folders to folders of your choice.

**Save project files to:** A folder for saving and opening projects. Autosave files for new projects are also saved in this folder. You can use them to restore your work in case of an error, freeze, or crash.
**Save output videos to:** A folder for exporting media files.
**Store audio recordings in:** A folder for audio clips that you record in Video Editor.

- If you delete these audio files, the audio recordings in the project will become unavailable.

**Store stabilized videos in:** A folder for a stabilized copy of the original when you stabilize a video.

- Don't delete these files while you are working on the project, or you'll have to stabilize the files again.

Changing where files are stored

Using a different folder may be useful if you don't have much disk space on your primary drive or if you want to organize your media files in another way.

1. Click the button with the three dots next to the folder you want to change.
2. A File Explorer dialog box will open. Choose the folder you want to save the files to.
3. Click **Select Folder** to use this folder.
Sharing preferences

On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.

To sign in:
1. Click Sign In. The authentication page will open in your browser.

![Sign In](image)

2. Sign in to your account.
3. On the next page, allow Movavi Video Editor Plus to upload videos to your account.

![Sign In with Google](image)

4. Return to Movavi Video Editor Plus. Your account username will be shown in the Preferences window.

To sign out or use a different account:
Click Sign Out. After this, you will need to sign in again to upload videos.
Acceleration preferences

Fast Track HD acceleration lets the program work with HD files faster. Tick this option so the editor can make smaller copies of the original files and use them in the project. For the proper work of this acceleration it's necessary to have free space on the driver. As soon as you start export, working copies will be changed back to the original ones.

Help and support

Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right away.

How to reach us
By email: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!

If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information about your system will allow us to help you faster.

Frequently Asked Questions
How to remove the trial watermark
What are the system requirements for using Movavi Video Editor Plus?
What formats does Movavi Video Editor Plus support?
More frequently asked questions

System requirements

Movavi Video Editor Plus can run on slower machines. However, we cannot guarantee stable performance if the minimum requirements are not met.

<table>
<thead>
<tr>
<th></th>
<th>Minimum system requirements</th>
<th>Recommended configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Mac OS® 10.7 or higher</td>
<td></td>
</tr>
</tbody>
</table>
**Processor**
- 64-bit Intel processor

**Graphics card**
- Intel® HD Graphics 2000, NVIDIA® GeForce® series 8 and 8M, Quadro FX 4800, Quadro FX 5600, AMD Radeon™ R600, Mobility Radeon™ HD 4330, Mobility FirePro™ series, Radeon™ R5 M230 or higher graphics card with up-to-date drivers

**Display resolution**
- 1280x800 screen resolution, 32-bit color

**RAM**
- 256 MB RAM

**Free disk space**
- 200 MB for installation
- 1 GB for smooth operations

**Other**
- Sound card for audio recording and playback
- Administrator permissions are required for installation

---

### Supported formats

Here you can view the list of formats and codecs supported by Movavi Video Editor Plus.

<table>
<thead>
<tr>
<th>Video Formats</th>
<th>Format</th>
<th>Codec</th>
<th>Read</th>
<th>Write</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Video Formats</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3GPP, 3GP2 (*3gp, *3g2)</td>
<td></td>
<td>H.263</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>ASF – Advanced Streaming Format (*asf)</td>
<td></td>
<td>H.264, MPEG-4</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>AVI – Audio Video Interleave (*avi)</td>
<td></td>
<td>H.264, MPEG-4</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>DivX Video (*divx)</td>
<td></td>
<td>DivX</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Flash Video (*flv)</td>
<td></td>
<td>FLV1, H.263, Flash Screen Video</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Flash Video (*swf)</td>
<td></td>
<td>FLV1</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MKV – Matroska (*mkv)</td>
<td></td>
<td>H.264, MJPEG</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>M2TS – MPEG Transport Stream (*m2ts)</td>
<td></td>
<td>H.264</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MTS – MPEG Transport Steram (*ts, *.mts, *.m2t)</td>
<td></td>
<td>MPEG-2, H.264</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MPEG (*mpg)</td>
<td></td>
<td>MPEG-1, MPEG-2</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MPEG (*mp4, *.mpe, *.m1v, *.mod, *.tod)</td>
<td></td>
<td>MPEG-1, MPEG-2, H.264</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MPEG-4 (*mp4)</td>
<td></td>
<td>MPEG-4, H.264</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MPEG-4 (*m4v)</td>
<td></td>
<td>H.263, MJPEG, ProRes</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MXF – Material eXchange Format (*mxf)</td>
<td></td>
<td>MPEG-2, DV</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>OGV – Ogg Video (*ogv)</td>
<td></td>
<td>Theora</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MOV – QuickTime (*mov)</td>
<td></td>
<td>MPEG-4</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>QuickTime (*qt)</td>
<td></td>
<td>H.264, MPEG-4, AIC, MJPEG, ProRes, Sorenson 1/3, PNG</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>RM – RealMedia</td>
<td></td>
<td>Real Video 2/3/4, Cooker</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>
You can view the full list of supported devices [here](#).

## Codec activation

Some video and audio codecs are patented by other companies, and new users are required to activate the codecs they use to comply with patent laws.

**Activate codecs on demand**
1. When you open a media file or export your project with one of these codecs, you may see a **Codec Activation** message.
2. Select the **Activate other codecs without asking** box to activate all codecs automatically in the future. The codecs will be activated automatically, but an Internet connection is still necessary.
3. Click **Activate** to complete the codec activation.

**Codec could not be activated**
If you see a codec activation error, make sure that you have a working Internet connection. If you are not connected to the Internet, the codecs cannot be activated even if you've chosen to activate them automatically. Once you've connected your computer to the Internet, please restart the application.

**What kind of data is sent?**
The data sent does not contain any information that can personally identify you. We only collect information about which codecs were used.

## Glossary

Here's a list of some terms that you may come across while working with video and audio. You don't need to know all of these to use Movavi software, but if you want to learn more about the specifics of media file processing, you can start here.

### Aspect ratio
A video's aspect ratio is the proportion of its width to its height (e.g., 16:9; read as **sixteen by nine**). You will usually encounter the 16:9 or 4:3 aspect ratios, but most recent displays and videos have a 16:9 aspect ratio. You might encounter 4:3 resolutions in older TV videos. Here's how they look:
If you join videos with different aspect ratios, you might see black bars on the sides. Think of a video's frame like a box: If you put a square peg into a rectangular hole, you will have room left over on the sides. This can happen in your project if you're mixing videos and photos or if you're using videos from different sources. This is what it might look like if you add 4:3 videos to a 16:9 project and vice versa:

![4:3 → 16:9](image)
![16:9 → 4:3](image)

To remove the black bars, try using the crop tool or change the project settings.

Learn more:
- Removing black bars

Bitrate
Bitrate is a property of digital video and audio files. It determines the amount of data in bits contained in each second of the video or audio. Higher bitrates allow the preservation of more detail but also require more disk space for the output file. The bitrate also depends on your video resolution because you need much more data to store a large HD video frame compared to a tiny 360p video. If your video contains lots of small details or fast action, you can choose a higher quality when exporting your project. The output video will have a larger file size, but you'll be able to see more details.

Codec
Video and audio information is processed, or encoded, to shrink the file size. However, your computer needs to have a decoder installed to open the file. There are many codecs, each compressing video in different ways. Many video formats can store multiple video formats. For example, you can save a video with the .mp4 extension, but you can use the H.264 or MPEG-4 codecs. If you don’t know what codec works best for you, go with H.264; it is supported by most players and platforms.

Tip: Don't download codecs from suspicious websites. They may contain malware.

Format
When talking about formats, we usually mean container formats, namely, the way of storing a video or audio track's information inside a file. You can tell container formats by their file extensions. A container format contains video and audio streams, which are encoded with a codec.

The figure below schematically shows the components of a video file.

![Video File](image)

Frame rate (FPS)
A video’s frame rate is the number of frames, or still images, in each second of the video (also called FPS, or frames per second). Most movies have a rate of 24 frames per second, but most cameras and cell phones shoot videos at 30 frames per second. More modern cameras even allow you to film at 60 FPS or higher. If you have a high frame rate, you can slow down the video to create a slow-motion effect without making the video look choppy.

*.mepb files
Movavi Video Editor project files are saved with the .mepb extension. You can open the file in the Editor and continue working on your project. If you upgrade to the Plus version, you will need to save the project file as an MEPX project.

*.mepx files
Movavi Video Editor Plus project files are saved with the *.mepx extension. You can open the file in the Editor and continue working on your project.

Resolution (frame size)
A video’s resolution is basically its width and height in pixels. It is usually written as width × height (e.g., 1280 × 720), but sometimes you might only see the height (e.g., 720p). Videos with a higher resolution usually have better quality because there are more pixels available for storing information. However, if you convert a low-quality video to a higher resolution, it will not look better because there is nowhere to restore extra

Learn more:
- Bitrate
- Codec
- Format
- Frame rate (FPS)
- *.mepb files
- *.mepx files
- Resolution (frame size)
information from, so you will end up with the same quality at a much larger file size. You can change the resolution of your output video in project settings.

Sample rate
The sample rate affects the quality of digital sound and determines the highest frequency that an audio stream can contain. The default sample rate is 44100 Hz, which exceeds the highest frequency humans can perceive and is used to record audio CDs and most music tracks.

Stream
A video file contains the video and audio information in separate streams, which simply means that their data is stored separately inside the file. When you play the file, these streams are played simultaneously, just like streams of water.

Export troubleshooting
Here you will find the most frequent problems with file export and instructions on how to solve them.

Unknown export error / Artifacts appear in a video
- Try another video format.

Try using another format for your video in the Export Settings window and click Start.

Movavi watermark
To remove the Movavi watermark from your video, you’ll have to purchase a license on our website to activate the program. You can learn how to activate the program here. Once you have activated the program, follow the steps below:
1. Open your project file by clicking File > Open project and select Export.
2. Export the video. The watermark will no longer be there.

Please note that it is impossible to remove the watermark from a video that you have already saved, but if you have a project file with the *.mepx (or *.mepb or *.meps) extension, you can save it again after activating the program. The watermark will then be removed.

Video and audio are out of sync
If video and audio in your project are out of sync, try selecting another video format:
1. Click Export below the player.
2. Select a video format (we recommend MP4).
3. Change other settings as desired.
4. Click Start to export your video.

Creating an Instagram video

Instagram videos have specific format and aspect ratio settings. Here you will find a guide for creating Instagram video posts.

Creating regular Instagram video posts
1. Add your video to the Timeline.
2. Click the clip and change its length by moving the borders. Change the length of all clips if you want. Note that the video can be from 3 to 60 seconds long.
3. On the player panel, click the aspect ratio button and select an aspect ratio from the list or set your own by clicking xy and setting a new ratio in the window that opens. For Instagram videos, the minimum aspect ratio is 1.91:1, and the maximum is 4:5.
If black bars appear, you can remove them using a special filter:
1. Click the Filters icon on the left sidebar.
2. In the Featured filters, select Vertical fill.
3. Drag the filter to the clip on the Timeline to blur the edges.

Exporting the video
Unfortunately, you can’t post your video on Instagram directly from Video Editor. You must first save it to your computer and then upload it to your Instagram account.
1. Click the Export button below the player.
2. Select the MP4 format from the list on the left.
3. Type a name for your video and click Browse to choose a folder to save it to.
4. Select the quality of your video.
5. Click Start to save the video.
Instagram does not limit the file size, but your video should be under 50 MB.

Creating videos for Stories
1. Add a video on the Timeline.
2. Set the desired length by moving the borders of the clip. Videos must be no longer than 15 seconds.
3. On the player panel, click the aspect ratio button and select an aspect ratio from the list or set your own by clicking \( \frac{x}{y} \) and setting a new ratio in the window that opens. Videos should have portrait (not landscape) orientation with an aspect ratio of 9:16.

Exporting the video
Unfortunately, you can't post your video to Instagram directly from Video Editor. You must first save it to your computer and then upload it to your Instagram account.
1. Click the Export button below the player.
2. Select the MP4 format from the list on the left.
3. Type a name for your video and click Browse to select a folder to save it to.
4. Select the quality of your video.
5. Click Start to save the video.

Videos should have a minimum frame rate of 30 FPS (frames per second) and a minimum resolution of 720 pixels. The maximum file size is 4 GB.

Creating videos for Instagram's IGTV
IGTV is an Instagram video type that can be longer than a regular video post.

How to edit a video to post it on IGTV
1. Add a video on the Timeline.
2. Set the desired length by moving the borders of the clip. If your account is not very big, you can upload a video lasting from 15 seconds to 10 minutes. If your account is verified and has a check, your video can be up to 60 minutes long.
3. On the player panel, click the aspect ratio button and select an aspect ratio from the list or set your own by clicking \( \frac{x}{y} \) and setting a new ratio in the window that opens. Vertical videos should have an aspect ratio of 9:16, while horizontal videos should be 16:9.

Exporting the video
Unfortunately, you can't post your video to Instagram directly from Video Editor. You must first save it to your computer and then upload it to your Instagram account.
1. Click the Export button below the player.
2. Select the MP4 format from the list on the left.
3. Type a name for your video and click Browse to select a folder to save it to.
4. Select the quality of your video.
5. Click Start to save the video.

Maximum sizes: 650 MB for videos shorter than 10 minutes and 3.6 GB for videos up to 60 minutes long.